PM1703MO-1BT/PM1401GNB
USER SOFTWARE GUIDE
Copyright

Copyright © 2009-2015. Polimaster. All rights reserved.

Reproduction, adaptation or translation without prior written permission is prohibited, except as allowed under the copyright laws.

Terms of Use

You will be prompted to agree to the terms of use when you install Polimaster PM1703MO-1/PM1401GNB User Software. The content of this guide is for information use only and is subject to change without notice. Polimaster assumes no responsibility for any errors or inaccuracies that may appear in this guide.

Trademarks

Polimaster®, PM1401® and PM1703® are registered trademarks of Polimaster Inc.

Third Party Trademarks

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation. All other product or service names are the property of their respective owners.
PREFACE

Using This Guide

Polimaster and our support team are committed to providing high quality technical support to the users of our equipment and systems. This manual is intended to familiarize user with the fundamentals of the Polimaster PM1703MO-1/PM1401GNB User Software. It includes a summary of the basic features, a detailed overview of advanced features, and the installation notes.

Conventions Used in This Guide

Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🖐️</td>
<td>Additional information you should pay attention to.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Information about potential danger for yourself, instrument or data.</td>
</tr>
</tbody>
</table>

Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IR</td>
<td>infrared</td>
</tr>
<tr>
<td>PC</td>
<td>personal computer</td>
</tr>
<tr>
<td>OS</td>
<td>operation system</td>
</tr>
<tr>
<td>CPS</td>
<td>counts per second</td>
</tr>
<tr>
<td>DER</td>
<td>dose equivalent rate</td>
</tr>
<tr>
<td>DE</td>
<td>dose equivalent</td>
</tr>
</tbody>
</table>
BEFORE YOU BEGIN

What is PM1703MO-1/PM1401GNB User Software?

Polimaster PM1703MO-1/PM1401GNB User Software is designed to work with the Polimaster PM1703MO-1BT/PM1401GNB Personal Radiation Detector/Dosimeters.

The PM1703MO-1/PM1401GNB User Software allows exchanging data between the instrument and PC, to change settings and extract data from non-volatile memory of the instruments and export, print and manage data.

System Requirements and Prerequisites

The following software and hardware specifications are required before using PM1703MO-1/PM1401GNB User Software:

- Microsoft Windows® XP, Vista, 7 or 8;
- Microsoft .NET Framework version 4.0 or higher;

The User Software is designed to work with any standard infrared (IR) adapter, compatible with the IrDA® standard.

Adapter must be already installed in the OS for the software to work properly. Procedure of IR-adapter installation is not a subject of this User manual. If you experience problems with the IR adapter, please refer to the adapter’s user manual or contact the seller/manufacturer.

Do not use this software with any other devices, including other Polimaster PM1703 or PM1401 models as this may damage equipment and void warranty.
Installing PM1703MO-1/PM1401GNB User Software

The PM1703MO-1/PM1401GNB User Software is based on the Microsoft.NET Framework (version 4.0 or higher). The installer will check the system and install it automatically if required. If the installer fails to do this, install the Microsoft.NET Framework manually according to its installation guidelines.

Please follow these steps for installation of PM1703MO-1/PM1401GNB User Software:

1. Run setup.exe file, located in the root directory of installation CD or memory drive to start the Setup Wizard.
2. Read and accept End User License Agreement.
3. Follow set up instructions to select installation folder and click the “Next” button to confirm and start installation.
4. After installation is completed, PM1703MO-1/PM1401GNB User Software is ready to start.
Troubleshooting

Most problems that may occur at installation phase that can prevent the PM1703MO-1/PM1401GNB User Software from running have been traced to mainly three areas below:

1. Microsoft .NET Framework is not installed in your system or its version is lower than 4.0. Please download the latest version of Microsoft .NET Framework from the web and reinstall it.
2. IR-adapter is not installed correctly. Please check with the Device Manager of OS and update the device driver if it shows a failure.
3. PM1703MO-1/PM1401GNB instrument has a low battery. Replace the battery and try to link the instrument and IR-adapter again.

If going through steps 1-3 above was still unsuccessful, please contact technical support.
OPERATING THE SOFTWARE

Quick Start

For the process of data exchange between the PC and Polimaster PM1703MO-1BT/PM1401GNB instrument to go smoothly, please follow the two-steps procedure described below.

**Step 1** – Initiate the IR-link between PM1703MO-1BT/PM1401GNB and PC

Although this can be done after starting the User Software, we recommend establishing IR-link between the instrument and PC beforehand. This can be done by pressing the backlight button of PM1703MO-1BT/PM1401GNB while in front of the IR dongle.

If the IR-link is established successfully, you will see the “Ir” message displayed on the PM1703MO-1 BT/PM1401GNB’s LCD screen and icon is displayed in Windows system tray.

**Step 2** – Start the PM1703MO-1/PM1401GNB User Software

After IR-link is established (IR-icon is ON), you may start the program from the Start Menu or using a corresponding desktop shortcut icon.

This will display the software information screen and after that the “Search for available devices” dialogue box will be opened suggesting the user find connected device and start working with PM1703MO-1 BT/PM1401GNB instrument:

Select the “Find” button and User Software will start searching for the instrument. If this operation is successful the main program window will be opened, showing the instrument’s serial number and firmware version:
If this operation fails, the following information window will be displayed:

![Device was not found](image)

In this case, please repeat Step 1 and make sure that IR-link is established and and IR-icon is displayed in Windows system tray. After that press the “Find” button again to search for the linked instrument.

If the following information message is displayed upon the first program startup, and the PM1703MO-1/PM1401GNBs User Software fails to start

![IR-adapter is not found](image)
please make sure that IR adapter hardware is installed properly and repeat Steps 1 and 2 again.

During IR-communication with the Software, the PM1703MO-1BT/PM1401GNB does not perform any search or measurement functions and all alarms are off.

In case you want to run the User Software without establishing connection with PM1703MO-1BT/PM1401GNB Instrument (with the IR-adapter properly installed), you may still select “Cancel” at the “Search for available devices” dialogue box and proceed to the main user program interface.
Main Window

The main program user interface window is divided in several functional areas:

Program command menus

There are three command menus in this section: **Device**, **Program** and **Help**.

1. **Device menu.** This menu contains the following commands that operate the PM1703MO-1BT/PM1401GNB instrument:
   a. “**Find**” command is used to activate the process of the instrument search in order to enable further instrument-software IR-communication;
b. “Refresh Device Settings” command is used to read currently active instrument settings and to undo unsaved changes;
c. “Read history” command is used to start instrument measurement history reading process followed by the read measurement history display as a graph and a table;
d. “Clear History” command is used to delete the instrument’s operation history from its memory;
e. “Clear Dose” command is used to delete the accumulated dose from the instrument’s memory;
f. “Factory reset” command is used to restore the Instrument to factory default settings;
g. “Exit” command is used to exit the software.

Operations “d.”, “e.” and “f.” from the list above cannot be undone and are password protected. When executed, the data will be erased permanently. You will be prompted to confirm this operation.

Critical operations with PM1703MO-1BT/PM1401GNB instrument are password protected. The User software will ask to enter the password upon the first attempt to change parameters and will keep it until the end of the working session.

2. Program menu. This menu contains the following commands:
   a. “Change password” command is used to change the password protecting critical operations;
   b. “Check for updates” command is used to check for available software or hardware updates;
   c. “Check for update on startup” command is used to check for available software or hardware updates on the program start;

3. Help menu. This menu contains the “About” command to show information about this Software.

Information area. The field is displaying connected instrument serial number and its hardware version.

Battery charge indication bar displays the battery charge level of the connected instrument.

Settings Toolbar. Toolbar buttons are used to change settings of PM1703MO-1BT/PM1401GNB instrument and are divided into the five groups: “Indication”, “Sound and Alarms”, “Behavior”, “Thresholds”
and “History”. Select the corresponding toolbar arrow button to open a corresponding group.

**The “History” button.** This button is similar to the “Read history” command of the Device Menu and is used to start instrument measurement history reading process followed by the read measurement history display as a graph and a table;

**Control buttons** at the bottom of the screen. These two frequently used buttons allow saving new software/instrument settings and/or undo unsaved settings and reload current instrument data again.
CHANGING PM1703MO-1BT/PM1401GNB SETTINGS

PM1703MO-1BT/PM1401GNB User Software allows changing the instrument’s settings that have impact on performance. Please make sure you understand all changes you want to make to device to avoid improper behavior of the instrument. In case of any problems please get back to manufacturer settings by executing “Factory reset” command from the Device menu.

Reading and Saving Instrument’s Settings

All operations start with reading settings from the instrument. After changes are done in program window there are two options: to save changes to the instrument’s memory or revert back.

To read the current instrument’s settings, select the “Refresh Device Settings” command in the “Device” menu of the main program window or click the “Refresh” button.

To save changes made to the instrument’s settings click the “Apply” button and select “Yes” in confirmation window. The software will reconnect with the instrument and write new settings into the instrument’s memory. Select “No” to cancel the operation.

To revert back to the current instrument’s settings after you made changes in the software, select the “Refresh Device Settings” command in the “Device” menu of the main program window or click the “Refresh” button.

It takes some time to write and read all settings into/from device memory. During this process the icon on the Windows taskbar will be displayed.

If IR-communication with the instrument fails, the following error message will appear:

Changing PM1703MO-1BT/PM1401GNB settings may lead to significant changes in the instrument specifications, including detection of radioactive sources. Polimaster is neither responsible nor liable for any consequential damages that may result therefrom. Do this at your own risk.
In this case re-establish IR-connection between the instrument and PC and try reading/writing settings again.

During IR communication, the PC System time will be recorded into the instrument and all downloaded history data will be tagged with current system time. Therefore check the system time before initiating the IR communication with the instrument and correct it if needed.

Understanding PM1703MO-1BT/PM1401GNB Settings

**Indication Tab**

**PM1703MO-1BT**

- Readings in R (REM)
- Display prefix "h"
- Display two digits after the decimal point

**PM1401GNB**

- Readings in R (REM)

This tab allows user to adjust instrument display and indication settings. The following parameters can be set up:

**Readings in R (REM)** – this option is used to select a measurement unit (Sv/h or R/h, Sv or R) of the instrument. Software will display the history data as well as thresholds in measurement units selected by this option;
CHANGING PM1703MO-1BT/PM1401GNB SETTINGS

Display prefix “0”s – this checkbox allows user to display insignificant preceding zeroes before the numerical value of the character display, i.e. 0005 µR/h versus 5 µR/h;

Display two digits after the decimal point – when this checkbox is selected, the instrument’s display resolution is two digits after the decimal point, when cleared – one digit after the decimal point.

Sound and Alarms Tab

PM1703MO-1BT

PM1401GNB

This tab allows user to adjust instrument sound and alarms behavior. The following parameters can be set up:

Enable sound alarms – this checkbox enables the sound alarm;

Enable vibro alarm – this checkbox enables the vibration alarm;

Enable button sound – when this checkbox is selected, button strokes are accompanied by a sound tone;

Enable start calibration beep – when this checkbox is selected the instrument will emit sound when background calibration starts;

Turn off the light alarm when the sound is off – when this checkbox is selected the instrument will disable the light alarm together with the sound alarm.
**Behavior Tab**

**PM1703MO-1BT**

![Behavior Tab](image)

- Quick shut down
- Allow dose reset
- Allow setting alarms
- Allow changing thresholds
- Search mode in 0..9

**PM1401GNB**

![Behavior Tab](image)

- Quick shut down
- Allow setting alarms
- Allow changing thresholds
- Auto calibration
- Neutron registration

This tab allows user to adjust instrument operation settings. The following parameters can be set up:

**Quick shut down** option is used to allow/prohibit the user to switch the instrument quickly off. When this checkbox is selected the instrument can be powered off by pressing backlight button for approximately 7 seconds.

**Allow dose reset** – when this checkbox is selected, the user can reset the accumulated dose value by means of the instrument’s buttons;

**Allow setting alarm** – when this checkbox is selected, the user can switch the audio and vibration alarms on and off by means of the instrument’s buttons;

**Allow changing thresholds** - when this checkbox is selected, the user can change the threshold value by means of the instrument’s buttons;

**Search mode 0..9** – when this checkbox is selected, the instrument will support 0..9 search mode instead of regular, as described in operation’s manual.

**Auto calibration** – when this checkbox is selected, the autocalibration of the instrument is allowed;
**Neutron registration** – when this checkbox is selected, the user can switch the neutron registration mode on by means of the instrument’s buttons.

**Thresholds Settings**

**PM1703MO-1BT**

![Thresholds Settings PM1703MO-1BT](image)

**PM1401GNB**

![Thresholds Settings PM1401GNB](image)

This tab allows user to adjust thresholds for different operation modes. The following parameters can be set up:

**Coefficient n, gamma** – this field allows setting the value of the number of measured deviations (coefficient n) for gamma radiation. The settings range is from 1.0 to 9.9. Manufacturer default value is 5.3;

**Coefficient n, neutron** – this field allows setting the value of the number of measured deviations (coefficient n) for neutron radiation. The settings range is from 1.0 to 9.9;

**Dose Rate Threshold (1)** – this field allows setting the first dose rate threshold (warning);

**Dose Rate Threshold (2)** – this field allows setting the second dose rate threshold (safety);

**Dose Threshold** – this field allows setting the accumulated dose threshold;
**0.9 Alarm Threshold** – is activated only when **0.9 Search mode** is enabled. Manufacturer default value is 25 µR/h.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The value of the first dose rate threshold shall be smaller than the value of the second dose rate threshold.</td>
</tr>
</tbody>
</table>

**History Tab**

This tab allows user to monitor and adjust the instrument’s settings that control data logging. The following parameters can be set up:

**History recording interval, min** – sets the time interval (in minutes) for background data logging to the internal nonvolatile memory of the instrument. The range is from 10 to 1440 minutes;

**Time delay until recording starts, min** – this field sets the delay interval (in minutes) before recording into the instrument memory starts. The range is from 1 to 1440 minutes.
WORKING WITH
PM1703MO-1BT/PM1401GNB HISTORY DATA

The PM1703MO-1BT/PM1401GNB instruments record the operation history into its non-volatile memory during its regular operation. The User Software allows downloading entire instrument’s history to PC, displaying, printing and exporting it to different file formats.

Use one of the following ways to start working with the instrument’s stored history data:

- click “History” button in the main program window, or
- select the “Read History” command in the “Device” menu.

If the IR-link between device and PC is established, the “History” window will appear displaying the data reading progress and if finished successfully all the history data in table and graph view:

Instrument operation history may contain the following events:

- Background dose rate values recorded at set time interval;
- Accumulated dose values;
- CPS gamma values;
WORKING WITH
PM1703MO-1BT/PM1401GNB HISTORY DATA

- Device On/Off event;
- All alarm events;
- Background calibration events in regular Search mode;
- Changing of n-coefficient in regular Search mode.

Events of dose and history clearance are not recorded into the operation history. If accumulated dose is cleared from the instrument the new reading of dose will start from zero.

**History Window and Menu**

The main History window contains the graph and table representation of downloaded data. No active IR-communication with the instrument is required to work with the read history (filter, print, save). However as soon as History window is closed all unsaved data will be lost.

Please complete all operations with data, print, export or save it before you exit the History window.

The following commands and operations are available with the downloaded data in History window:

**“Data” menu commands:**

- “Read” command is used to start instrument operation history reading;
- “Stop” command is used to stop the reading when required;
- “Print” command is used to print the current history;
- “Export” command is used to save the current history onto the user PC or a removable flash-drive as a *.xls file;
- “Exit” command is used to exit the mode.

**“View” menu commands:**

- “Show CPS, Gamma” option. Select this option to display gamma CPS data in the history table;
- “Show Dose Rate” option. Select this option to display dose rate data in the history table;
- “Show Dose” option. Select this option to display dose data in the history table.
Event Filters

Displayed history can be filtered right in the table as well as from the “View” menu.

Filtration by event types

To filter history events by event type click the “Type” column to open the filter. Select required events from the list or chose “Select All” to see the selected history events range.

Filtration by date

To filter the history events by date: click the “Date, Time” column to open the filter and select required display options from the calendar window.

Exporting History Data

Polimaster PM1703MO-1BT/PM1401GNB User Software allows to export history events onto the user PC as a *.xls file as well as other file formats. Only currently displayed history events will be saved (according to applied filtration criteria).
To save the history as a *.xls file open the “Data” menu and select the “Export” command. A standard “Save As” dialogue box will be opened suggesting the user to set the name of the file and a folder.

To save the history file in another format:

- Select the “Print” command from the “Data” mode menu. A standard print preview window will be opened;
- Select the “Export Document…” command from the “File” menu in the “Preview” window;
- Select a format form the drop-down list and adjust required settings in the opened dialogue window. A newly saved document can be immediately viewed if required.

Printing History Data

Software allows printing of currently displayed history from the “History” mode window.

Only currently displayed history events will be printed (according to applied filtration criteria).

Select the “Print” command from the “Data” mode menu. A standard print preview window will be opened:
Adjust required print settings and select the "Print" command from the "File" menu.
Displaying User Guide

In case any help or reference is needed, please consult this User Guide. It can be always found at the root directory of installation CD or memory drive.

Checking for Updates

Polimaster Inc. will provide updates to PM1703MO-1BT/PM1401GNB User Software and documentation at the Polimaster website (http://www.polimaster.us/). Check the website periodically for important updates.

Technical Support

If you have technical questions about PM1703MO-1BT/PM1401GNB User Software, contact your local Polimaster Technical Support or report to support@polimaster.us. If possible, save the design, image and/or output files related to the problem.